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What is new in this release? 
All sections have been updated per your requests, check particularly: 

• HC12 Special Edition code size limit is increased to 32K memory (see Special Edition) 
• New derivatives supported (see specifications, service packs) 
• More on Processor Expert Basic and Advanced Beans (see Processor Expert Beans) 
• New Multilink and SofTec targets (see hardware products) 
• New part numbers (see software and hardware products) 
• More on licensing, getting started, links, documentation and Q&A’s 
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1 Software Products Description 
CodeWarrior Development Studio for 68HC(S)12 is an integrated suite of tools containing all the 
components needed to bring an application from the concept stage to the release to the market of a finished 
product. 
 
CodeWarrior Development Studio contains the following set of tools: 

*  A new Data Expert Edition using Encirq3e™ technology(1) 
*  Integrated Development Environment (IDE) 
*  Project Wizard, Project Manager 
*  Processor Expert™ with Beans™ (2) 
*  Editor, Compiler, linker and Macro/Absolute Assembler  
*  Graphical Debugger with new Debug Module and multi-target interface capability 
*  Full Chip Simulator with Data Visualization and I/O Stimulation (3) 
*  Flash programming tools 
*  Many features can be set to user’s preferences with the project preferences panel and the targets 
preferences panels. 

 
(1) Encirq3e is a data management application design tool for generating extremely compact and high-
performance data management components (see section on Encirq3e).  
(2) Processor Expert helps save design time by assisting the user in the definition of the application 
environment and generating support code without having to read and learn a lot about the device, its 
peripherals, the registers and their bit field settings (see section on Processor Expert). 
 (3) Data Visualization helps save debugging time (especially with the simulator before hardware is 
available) by providing a graphical display of bit status and byte values. I/O Stimulation provides graphical, 
real-time control of bit levels or byte values as inputs to the application. 
 

2 Specifications 

2.1 Version of products 
Release 3.1  Current release of CodeWarrior Development Studio for HC(S)12.  
 

• The HZ256 service pack supporting the MC9S08HZxx family will be posted on the CodeWarrior 
download page in September 2005. It will be on the October Service Pack CD. 

• The next release (R5.0) is scheduled for December 2005. A beta version will be released in August 
2005. It will combine the HC12 and HCS12X products and have the following features: 

o IDE 5.7 
o Provide support for small projects 
o Enhanced drag & drop capability in data windows (user data, expressions) 
o Pack and Go (complete project) capability to enable better tech support  
o Update Project Wizard to explain steps  
o Ability to stop at a user defined location after load or reset 
o Improve support for multiple data windows (freeze mode) 
o Ability to display data in different format in one single data window  
o Implement conditional linking command 
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o Fixed identified bugs in the database 
o Documentation update 
o Provide IDE “Tip of the Day” feature 
o Contant display is selectable in Assembly window. 
o Enhanced build tools 
o Encapsulate all the service packs issued for release 3.1 

 
 

2.2 Processors supported by the current release (without service pack) 
CodeWarrior tools for 68HC12 and HCS 12 derivatives in production at the time of its development. New 
derivatives are (and will be) supported by ‘Service Packs’ until the next release. 
For latest update, visit http://www.metrowerks.com/embedded/hc12/default.htm 
 
- MC9S12A32/A64/A128B/A256B/A512 
- MC9S12C32 
- MC9S12D32/D64 
- MC9S12DB128A/DB128B 
- MC9S12DG128B/DG256B 
- MC9S12DJ64/DJ128B/DJ256B 
- MC9S12DP256B/DP512 
- MC9S12DT128B/DT256B 
- MC9S12E64/E128 
- MC9S12T64 
 
- MC68HC812A4 
- MC68HC912B32 
- MC68HC912D60/D60A 
- MC68HC912DG128/DG128A 
- MC68HC912DT128/DT128A 

 
Please note that 68HC12 derivatives will appear in the ‘Legacy’ stationery and are not supported by 
Processor Expert. Only HCS12 derivatives have Processor Expert support. 
 

2.3 Service Packs available for new derivatives 
Service Packs are packages developed to support new derivatives (full new stationery or complement of the 
stationery). “New derivatives” are devices introduced after the release of CodeWarrior. 
Service packs are available from our web site (see links at the end of this document). Whenever possible, 
these service packs will be integrated into the next release. 
 
Service Packs for derivatives introduced after Release 3.1: 
 

• CW12 V3.1 B128 Service Pack    (August 9, 2004) B64, B128 
• CW12 V3.1 C128 Service Pack  (August 9, 2004) C64, C96, C128 
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• HC12 Processor Expert V2.94 Service Pack (August 30, 2004) Adds PE beans for B64, B128, 
C64, C96, C128, KG128, KT128, 
KT256, UF32 

• CW12 V3.1 UF32 Service Pack    (September 8, 2004) UF32 
• CW12 V3.1 GC128 Service Pack    (September 8, 2004) GC16, GC32, GC64, GC128 
• CW12 V3.1 E32 Service Pack    (September 8, 2004) E32 
• CW12 V3.1 KT256 Service Pack    (September 8, 2004) KT128, KT256 
• HC12 Processor Expert V2.94.01 Patch   (September 9, 2004) Updates NE64 Ethernet bean 
• CW12 V3.1 NE64 Service Pack (September 20, 2004) NE64 
• CW12 V3.1 H256 Service Pack    (October 6, 2004) H256, H128 
• CW12 V3.1 KG128 Service Pack    (October 6, 2004) KG128, KG64 
• CW12 V3.1 USB 2.0 Service Pack (January 11, 2005) Adds support for P&E USB 2.0 

BDM Multilink (rev B) 
• CW12 Processor Expert Update V2.95 (March 17, 2005) Adds PE beans for E32, 

GC128, GC64, GC32, GC16, 
and H256 

• CW12 V3.1 E256 Service Pack    (May 23, 2005) E256 

2.4 Board supported (see also the hardware section) 
We try to have stationery support for evaluation boards that we receive information on (see useful links 
section.). This support can take the form of a stationery folder generated by Metrowerks or by the vendors 
themselves (see section on useful links). The support can also be in the form of a tutorial on how to download 
and run the code. 
 

- Freescale MC68HC9S12DP256 Evaluation Board 
- Technological Arts Adapt912xxx boards 
- SofTec Microsystems InDART and PK solutions are supported by CodeWarrior (SofTec CD). 
 There are solutions for both HC12 and HCS12 derivatives. 
- Axiom CML125-DP256 board 
- Future Electronics  9S12 Badge board 
- Electronik-Laden  HCS12 T-board 

 

2.5 Languages supported (depending on the edition) 
All CodeWarrior Development Studio for HC(S)12 support absolute assembly with no limitation. The 
Standard Edition supports C with options to upgrade to C++ (and compact C++ for small memory footprints). 
The Professional Edition supports all these languages with no limitation.  

2.5.1 Assembly 
Develop in the old way with absolute assembly or in a more complex form with multiple relocatable 
assembly files, cross-referenced labels and variables but still close to the code with full control of the 
performance. 
There is no code size limitation on development in assembly mode. 

2.5.2 C 
C is code-size limited to 32Kbytes of code in the ‘free of charge’ Special Edition. There is one upgrade 
license keys from the Special Edition:  64Kbytes. C is unrestricted with the Standard Edition and the 
Professional Edition. 
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2.5.3 C++, Compact C++ and EC++ 
For evaluation purpose only, C++ is limited to 1Kbytes of code in the Special and the Standard Edition. 
There is an upgrade license key for the Standard Edition. C++ is unrestricted with the Professional 
Edition. 

2.5.4 Language support 
Each template in the stationery also contains header files with description of registers, bytes and bits as 
they appear in the derivatives’ user manuals to make easier the writing of the code. Templates have the 
project entirely set up so that developers can concentrate on writing the application code in the ‘main’ 
section of the program as indicated in the source file: “ /* write your code here */ ”. 
Templates are also prepared for several “targets” allowing the developer to select the right set of files 
and move quickly from full simulation to evaluation board and customer’s target without extra work. 

 

3 Unrivaled Features but so easy to use 
CodeWarrior for HC(S)12 has been designed to simplify the development of microcontroller-based 
applications by helping engineers concentrate on the key part of their project: writing the code. 
CodeWarrior can be made as simple to use as small assembly-code applications require or as feature-full as 
the most demanding developers can ask for. Furthermore, CodeWarrior for HC(S)12 combines several tools 
whose features are unrivaled today: The Processor Expert tool at the definition phase of a project with its 
libraries of standard, complex and software beans™, and the enhanced Simulator/Debugger with Data 
Visualization and I/O Stimulation capability to shorten the debugging phase of a project. 
 

3.1 Encirq3e™ 

Encirq3e Data Expert is the rapid application design tool for generating extremely compact, high-
performance data management components. The tool can be used with Metrowerks CodeWarrior 
Development Studio and includes: 

•  Encirq \DB™ Prototyper & Generator 
-  Use the Prototyper to interactively test or extend functionality, and dynamically execute each 

statement, 
-  Add data or code into the data management logic for testing, while tuning algorithms and data 

structures, 
-  Use the Generator to analyze the data management logic and generate optimized C code and .h files for 

the entire code, data, queries, functions, and database operations 

•  Encirq \PL™ Program Logic Language 
-  Based on the industry-standard, proven, and popular data management language Oracle PL/SQL, with 

extensions to meet the unique demands of embedded and advanced development, including powerful 
error and exception handling 

-  Supports data types: BOOLEAN, CDOUBLE, CINT, CLONG, CSHORT, CURSOR, DATE, DOUBLE, INT, 
INTEGER, NVARCHAR, POINTER, RECORD, SHORT, STREAM, TIMESTAMP, VARCHAR, VARCHAR2 

-  Use stored functions in applications, as if they were C functions 
-  Invoke application C functions from stored functions 

Encirq \SL Runtime Libraries 
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The runtime libraries consist of the Encirq3e Streaming Data Engine for dynamic real-time data 
manipulation, storage and retrieval. 

Benefits 
•  Rapid creation of optimized, application-specific C source code data logic 
• Small code and data footprint 
• Adaptable API to meet the needs of current and new applications 
• Transaction support and data integrity (rollback, recovery) 
• Manages data in both RAM and persistent data storage (NVRAM) 

 

3.2  Processor Expert™ 

Processor Expert is a Rapid Application Design (RAD) tool that combines easy-to-use component based 
application creation with an expert knowledge system. Functionality of CPU and on-chip peripherals as well 
as higher levels of specific applications are encapsulated into components called Embedded Beans. 

This powerful tool frees up developers from the long effort of learning bits and bytes of new peripherals and 
how to properly set them up to implement the desired functions by 
allowing the developer to describe how built-in peripherals and 
their hardware environment will be used and automatically 
generate the code to properly initialize, write to and read these 
peripherals. 

This tool dramatically saves the time to learn about a new device 
and the time to correct mistakes and help concentrate on the real 
part of the application, the added value of a project.  
See ‘useful links’ and ‘documentation’ 

3.1.1 Processor Expert Beans 

3.1.1.1 Peripheral Initialization Beans 

Peripheral Initialization Beans are a subset of Processor Expert Beans and provide the lowest level of 
hardware abstraction. With Peripheral Initialization Beans the user is able to configure the control 
registers for each of the peripherals on the silicon and Processor Expert generates the necessary 
initialization code. 

- Init_ADC_HCS12 Analog-to-Digital Converter (ADC) 
- Init_BDLC_HCS12 Society of Automotive Engineers (SAE) J1850 serial  

 communication network. (BDLC) 
- Init_BYTEFLIGHT_HCS12 Byteflight communication interface (BYTEFLIGHT) 
- Init_ECT_HCS12 Enhanced Capture Timer (ECT) 
- Init_EEPROM_HCS12 EEPROM Memory (EEPROM) 
- Init_FLASH_HCS12 Flash Memory (FLASH) 
- Init_IIC_HCS12 Inter-IC Bus (IIC) 
- Init_MSCAN_HCS12 Motorola Scalable Controller Area Network (MSCAN) 
- Init_PMF_HCS12 Pulse width Modulator with Fault protection (PMF) 
- Init_PWM_HCS12 Pulse Width Modulator (PWM) 
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- Init_RTI_HCS12 Real Time Interrupt(RTI) 
- Init_SCI_HCS12 Serial Communications Interface (SCI) 
- Init_SPI_HCS12 Serial Peripheral Interface (SPI) 
- Init_TIM_HCS12 Timer Interface Module(TIM) 

See ‘useful links’ and ‘documentation’ 

3.1.1.2 Basic Beans 

Basic Beans (or standard beans) refer to the basic blocks such as parallel ports, timers, A/D converters, 
and simple serial interfaces as well as simple functions using them. The Basic Beans are listed below. 
Basic Bean support is dependent on the peripherals and pins available on a particular derivative. 

- ADC A/D converter 
- ADfast A/D converter with channel dependency 
- AsynchroSerial Asynchronous serial communication 
- BitIO General 1-bit Input/Output 
- BitsIO General Multi-Bits Input/Output (1-8 bits) 
- Bwimage Black & White image 
- Byte2IO General Two-Bytes Input/Output 
- Byte3IO General Three-Bytes Input/Output 
- Byte4IO General Four-Bytes Input/Output 
- ByteIO General Byte Input/Output (8 bits) 
- Capture Timer capture encapsulation 
- COLimage Color image 
- DAC D/A converter 
- EventCntr16 Event counter 16-bit 
- EventCntr32 Event counter 32-bit 
- EventCntr8 Event counter 8-bit 
- ExternalI2C External I2C Communication Interface 
- ExtInt External interrupt 
- FreeCntr Free running counter 
- FreeCntr16 Free running 16-bit counter 
- FreeCntr32 Free running 32-bit counter 
- FreeCntr8 Free running 8-bit counter 
- InputPin General 1-bit Input 
- IntEEPROM Internal EEPROM 
- InterruptVector Interrupt vector handled in user code 
- PPG Programable pulse generation 
- PulseAccumulator Pulse Accumulator 
- PWM Pulse width modulation 
- RTIshared Real Time Interrupt Shareable 
- SWSPI Software synchronous serial communication 
- SynchroMaster Master for synchronous serial communication 
- SynchroSlave Slave for synchronous serial communication 
- TimerInt Periodic interrupt 
- TimerOut Flip-flop output 1:1 
- WatchDog WatchDog bean 
- WordIO General Word (16-bit) Input/Output 
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See ‘useful links’ and ‘documentation’ 

3.1.1.3 Software Beans 

The Software Beans library is a collection of software modules developed to interface to popular 
external peripherals such as serial SPI sensors, LCD modules, Flash memory modules, A/D and D/A 
converters as well as implementing low level functions such as keyboard matrix, software SPI function, 
7-segment display or simple FFT or FIR functions. These beans are ‘free of charge’ to customers 
purchasing the Standard Edition of CodeWarrior. 
See ‘useful links’ and ‘documentation’ 

3.1.1.4 Advanced Beans 

Advanced Beans (or complex beans) refer to the beans supporting complex peripherals such as complex 
A/D conversions. The Advanced Beans are listed below. Advanced Bean support is dependent on the 
peripherals and pins available on a particular derivative. Advanced Beans are available to customers 
purchasing the Professional Edition of CodeWarrior. 

- ADconverter A/D converter 
- AsynchroMaster Asynchronous serial communication - master 
- AsynchroSlave Asynchronous serial communication - slave 
- BDLC BDLC serial communication 
- Byteflight Byteflight communication interface 
- Ext16IO External 16-bit Input/Output 
- Ext32IO External 32-bit Input/Output 
- Ext8IO External 8-bit Input/Output 
- ExtBitIO External 1-bit Input/Output with Direction Register 
- ExtByteIO External Byte Input/Output (8 bits) with Direction Register 
- ExternalFile External Binary File Converter 
- FreescaleCAN CAN communication for Freescale implementation 
- FreescaleEMAC Configuration modes for MC9S12NE64 EMAC start-up 
- FreescaleEthernetAPI NE64 ethernet API routines 
- InternalI2C Internal I2C Communication Interface 
- IntFLASH Internal FLASH 
- OSEK_OS Encapsulation of OSEK/VDX compliant OS - HW specific 

configuration 
- PWMMC Pulse width modulation for motor control 
- StringList String List Converter 
- Term ANSI Terminal 
- TimeDate Time and date 

See ‘useful links’ and ‘documentation’ 
 

3.1.2 Bean Wizard™ 

The Bean Wizard™ is the tool that allows you to create your own beans that address the specific needs of an 
application, like the support of using a generic peripheral in a very specific way. 
See ‘useful links’ and ‘documentation’ 
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3.2 Smart Linker 

The smart linker is a panel with graphical adjustment of different 
parameters to optimize the code. No need to remember complex 
command lines to set multiple parameters during compilation and 
linking process. More than 50 different optimizations can be 
achieved with the control panel of the Smart Linker. Adjust for 
code density, execution speed, compilation time or information 
available from the tools and the equivalent command line is 
displayed so you can remember what setting was used.  
See ‘useful links’ and ‘documentation’ 

3.3 Data Visualization & I/O Stimulation 

The Data visualization, with the complementary function of I/O stimulation is 
a tool that allows the developer to attach graphical representation of hardware 
functions to the input and/or output registers of peripherals and display the 
real-time status of the functions implemented by the peripherals. Typical and 
simple examples are LEDs and bar graphs displays, switches and 
potentiometers. 

Command files can be attached to these functions to expand the capability to 
provide stimulation and display of the direct environment of the 
microcontroller used for the application, getting closer to the final hardware and before code is downloaded 
in the application. 

This tool significantly accelerates the development of an application by allowing the validation of the 
software part of the application before downloading it to the platform, thus isolating hardware related 
issues. Another benefit is the ability to test and validate “hardware” changes at the simulation level with 
the time and product savings such a feature allows. 
See ‘useful links’ and ‘documentation’ 

3.4 High Level Application Design 

3.4.1 The MathWorks 

The MathWorks Embedded Target for Freescale® HC12 lets you deploy production code generated from 
Real-Time Workshop® Embedded Coder directly onto the HC12 microcontroller. You can use the Embedded 
Target for Freescale HC12 to execute code in real time on the Freescale HC12 for rapid prototyping or 
production deployment of embedded applications. 
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4 Features of Special, Standard, Professional and Data Expert Editions 
CodeWarrior for HC(S)12 is available in different versions to suit customers’ needs. 
 

Special Edition Standard Edition Professional Edition Data Expert Edition 
 

CWX-HXX-SE CWS-H12-STDED-CX CWS-H12-PROED-
CX 

CWS-H12-DXP-
CX 

 

C
W

S-
H

12
-

C
64

K
-C

X
  

  
C Compiler  
object code size 

32 Kbytes 64Kbytes Unlimited code size 
(Asm, C) 

Unlimited code size 
(Asm, C, EC++/C++) 

Unlimited code size 
(Asm, C, 

EC++/C++) 

CODEWARRIOR 
IDE 5.x 32 files Unlimited Unlimited Unlimited Unlimited 
Macro Assembler Y Y Y Y Y 
Pre-configured Projects Y Y Y Y Y 
Flash Programming Y Y Y Y Y 
Full Chip Simulator Y Y Y Y Y 
Data Visualization 1 component, 3 elements Unlimited Unlimited Unlimited 
I/O Stimulation 1 component, 3 elements Unlimited Unlimited Unlimited 
Decoder   Y Y Y 
Libmaker   Y Y Y 
Session Record & Play    Y Y 
OSEK awareness    Y Y 
PC-Lint Plugins    Y Y 
PROCESSOR EXPERT 
Basic Beans Y Y Y Y Y 
Software Beans   Y Y Y 
Advanced Beans    Y Y 
Bean Wizard    Y Y 
DATA EXPERT 
Prototyper & Generator     Y 
Program Logic Language     Y 
Runtime Libraries     Y 
ENHANCING OPTIONS 
C++, compactC++/EC++ 1Kbytes 1Kbytes CWX-H12-ENHNC-KX Y Y 
Code Coverage   CWX-HXX-CCODEC-KX Y Y 
Profiler, performance 
analysis   CWX-HXX-PROFL-KX Y Y 

C Source Encryption 
tools   CWX-H12-ENCRY-KX Y Y 

TARGETS (parallel, serial or USB) 
HCS12 Serial Monitor Y Y Y Y Y 
P&E Multilink(s) Y Y Y Y Y 
SofTec USB Y Y Y Y Y 
HC(S)12 GDI Y Y Y Y Y 
HC12 DBG support Y Y Y Y Y 
Lauterbach emulator    Y Y 
Hitex Emulator    Y Y 
Abatron BDI1000    Y Y 
D-Bug12 (1) (1) (1) (1) (1) 
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(1) D-Bug12 works with CodeWarrior Release 2.x only. It has not been updated to support new commands of 
CodeWarrior release 3.1 
 

4.1 Technical support 
- Technical support gives access to trained applications engineers who can help customers, 
- Technical support also entitles customers to purchase new releases with a 70% discount, 
- First year of technical support is included in the price, 
- Subsequent years of technical support must be purchased to continue coverage and be entitled to 

discounts mentioned above. 
 

4.2 Special Edition 
TARGET: Special Edition is targeted at assembly code projects or small projects with a limited amount 

of C code. Debugging is mostly done with Evaluation Boards or directly on the target application. 

Features: there are some limitations to the Special Edition: 
- Unlimited assembler 
- C compiler limited to 32Kbytes of object code  

(There is no code size limitation when developing in assembly.) 
- Linker limited to 32K of C code  
- IDE limited to 32 files and no-sub-projects 
- Projects can have up to 4 targets 
- Data Visualization/IO stimulation allows for 1 component with 3 instruments 

Options available for the Special Edition 
For customers developing C based applications and using more than 32Kbytes of code, two C compiler 

options are available, a 64Kbytes option and a full C compiler option. 

The C compiler upgrade to the full 64Kbytes offers: 
- C compiler object code increased to up to 64Kbytes (1K of C++) 
- No file limitation for the IDE 
The C compiler upgrade offers: 
- Unlimited C compiler (1K of C++) 
- No file limitation for the IDE 

 

4.3 Standard Edition 
TARGET: Standard edition is targeted at projects developed with C, assembly or a mix of the languages 

and use the maximum memory size of the 68HC(S)12 derivatives that today have 128K, 256K and 
512Kbytes. It adds the possibility to closely simulate the interfaces to the processor, making the 
debugging easier and the time to market shorter. 

Features: Standard edition has more features than the Special Edition: 
- Unlimited Data visualization to improve debugging 
- Access to Unis’ software beans to accelerate application designs 
- Unlimited C compiler / debugger code size (C++ limited to 1Kbytes) 
- No limitation on number of files/Subprojects 
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- Libmaker to create binary libraries  
- Decoder to create a listing from ELF files 

Customers can also upgrade from Special Edition to Standard Edition. 
 
Enhancing options available for the Standard Edition 
Standard Edition can be complemented with a number of options to improve developers’ productivity: 
- C++/EC++/Compact C++, 
- Code Coverage that allows the user to isolate unused or badly used portions of code, 
- Profiler/Performance Analysis to identify and optimize critical portions of code, 
- C source encryption tools 
 

4.4 Professional Edition 
TARGET: Professional Edition is targeted at professional, short time to market applications. Developers 

benefit from a number of unrivaled features available in the CodeWarrior tool suite to develop the 
most complex applications and meet short time to market goals. 

Features: Professional Edition includes all the features of the other editions plus: 
- C++/Compact C++/EC++ for object-oriented programming 
- Code Coverage that allows the user to isolate unused or badly used portions of code, 
- Profiler/Performance Analysis to identify and optimize critical portions of code, 
- Advanced beans providing higher level software modules and faster code integration, 
- Bean Wizard to build a software library that can be retargeted to any HC(S)08 or HC(S)12 silicon  
- OSEK awareness for kernel-level debugging 
- Session Record and Play for automated testing 
- Encryption tools, 
- Support of third Parties emulators (Lauterbach, Hitex). 
 
Customers can also upgrade from Standard Edition to Professional Edition. Upgrading from Special 
Edition will be charged as 2 upgrades: a Standard Edition upgrade and a Professional Edition upgrade. 
 

4.5 Data Expert Edition 
TARGET: Professional edition is targeted at professional, short time to market applications. Developers 

benefit from the unrivaled features available in the CodeWarrior Professional Edition plus the Data 
Expert design tool (from Encirq) to develop the most complex applications and meet short time to 
market goals. 

Features: Professional edition includes all the features of the other editions plus the tools, components, 
and libraries for the rapid creation of compact, customized, full-featured data management 
applications for the Freescale HC(S)12 Family of Microcontrollers.  The Encirq 3e relational 
database technology has been adapted for the unique requirements of the HC(S)12 and is working 
seamlessly with CodeWarrior Development Studio.  It contains support for large, banked and small 
memory models – the only data management solution available today for 16-bit microcontrollers. 

5 Additional Support 
CodeWarrior for HC(S)12 has the capability to provide additional support for specific functions.  
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5.1 OSEK 
The CodeWarrior Development Studio for HC(S)12 Professional Edition is ‘OSEK aware’. 

5.2 PC-Lint 
PC-Lint is a software package that finds errata in your C programs using the K&R and ANSI standards 
for C. The purpose of linting your programs is to determine potential problems prior to integration or 
porting, or to reveal unusual constructs that may be a source of subtle errors. PC-Lint often finds 
problems that the compiler alone cannot. 
 
The CodeWarrior Development Studio for HC(S)12 Professional Edition has PC-Lint plugins. 

5.3 MSCAN 
The CAN LLD’s were developed with a Toucan interface for HC08, HC12 and MPC5xx.  

5.4 LIN 
The LIN drivers are available free of charge from Freescale. 
 

6 Why update and upgrade? 
There are multiple reasons to upgrade to a new release, upgrade from Special Edition to Standard and 
Professional Edition but the most important one is that it will save money in the long run by reducing the 
design time, improve re-use and improve the quality of the product, leading to lower maintenance costs. 

6.1 Upgrade to Professional Edition 
These new features are ALL available in the Professional Edition. Check out the 'Release Notes' folder (or 
menu Help > Online Manuals in the IDE). 

- New stationery wizard: menu File > New and then 'HC(S)12 New Project Wizard. 
- New and updated support for HC(S)12 families 
- New standard monitor for HCS12 (featuring on-chip DBG/Trigger module and trace) 
- BDM support for HCS12 (featuring on-chip DBG/Trigger module and trace) 
- On-chip DBG module including trace for HCS12 
- New IDE 5.x featuring code completion, docking windows and Processor Expert project tab 
- New/updated compiler to support HCS12 devices (-Cs12 compiler option) 
- New/updated assembler to support HCS12 devices (-Cs12 assembler option) 
- Updated prm and library files for existing and new derivatives 
- Updated debugger/simulator files 
- New visualisation tool in the debugger supporting additional instruments/properties 
- Updated online documentation with extended search capability (Help > Online Manuals) 
- New Burner utility to support path suppression in the S0 record 
- New decoder utility to support HCS12 instruction set 
- Updated ClearCase version control plugin 
- Added COM/Scripting interface to the simulator/debugger 
- Updated PC-lint configuration files (matching latest PC-lint release) 
- Additional .chm searchable help files (see Help > online manuals) 
- Board support stationeries are now on top level (File > new) 
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- P&E PEDebug: new derivatives/FCS 
- Updated Processor Expert supporting new HCS12 architecture 

6.2 Upgrade to Standard Edition 
Standard Edition adds many features to the Special Edition: 

- Data visualization/IO stimulation to improve debugging 
- Access to Unis’ software beans to accelerate application designs 
- No limitation on C code size 
- No limitation on number of files the linker can handle 
- Libmaker to create binary libraries  
- Decoder to create a listing from ELF files 

Standard Edition also offers the possibility to add extra features needed for a specific development: 
C/C++, Code Coverage, C Source code Encryption tools, Profiler/Performance Analysis. 

6.3 Upgrade C compiler of Special Edition 
The C compiler upgrades to 64Kbytes or unlimited are for users of the Special Edition requiring more than 
32Kbytes of code. The use of C code offers portability, faster debugging and design of complex applications 
that would be very difficult to debug at the assembly level. 

The C64 upgrade allows up to 64Kbytes of code to be generated and the C-compiler upgrade allows 
unlimited code to be generated. 

All upgrades remove the file limitation for the linker of the 32Kbyte initial version. 
 

7 Software Products: Part numbers 
Base Product Part number 
HC12 Special Edition is now distributed in a 3-CD DVD pack 
with HC(S)08 Special Edition and Service Pack CD CWX-HXX-SE 

Standard Edition CWS-H12-STDED-CX 

Professional Edition CWS-H12-PROED-CX 

Data Expert Edition CWS-H12-DXP-CX 
Options for Special Edition Part number 
C compiler/debugger Upgrade to 64 Kbytes for Special Edition CWS-H12-C64K-CX 
C compiler/debugger (unlimited) for Special Edition CWS-H12-CC-CX 
Options for Standard Edition Part number 
C++ / Compact C++ option for Standard Edition CWX-H12-ENHNC-KX 

Code Coverage option for Standard Edition                       CWX-HXX-CODEC-KX 

Profiler, Performance Analysis option for Standard Edition  CWX-HXX-PROFL-KX 

Encryption tools CWX-H12-ENCRY-KX 
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Product Upgrades Part number 
Upgrade from Special Edition to Standard Edition CWS-H12-STDED-UX 

Upgrade from Standard Edition to Professional Edition CWS-H12-PROED-UX 

Upgrade from Professional Edition to Data Expert Edition CWS-H12-DXP-UX 
Technical Support  Part number 
1 year technical support for 64K C upgrade CWT-H12-C64K-TX 

1 year technical support for C Compiler upgrade CWT-H12-CC-TX 

1 year technical support for Standard Edition CWT-H12-STDED-TX 

1 year technical support for Professional Edition CWT-H12-PROED-TX 

 

8 Hardware Products 
There are several hardware connections available to suit the needs of the most demanding. CodeWarrior has 
built-in drivers to communicate with these different interfaces and make the function transparent to the user. 
Many connections are now available: 

- Standard RS232 to Serial monitor (HCS12 devices with flashed monitor) 
- Multilink parallel to BDM for HCS12 (will be replaced by USB to BDM) 
- Multilink USB to BDM for HCS12 
- CyclonePRO serial/USB/Ethernet to BDM (HC12 and HCS12) 
- SofTec inDart USB to BDM for HCS12 

CodeWarrior Development Studio for HC(S)12 Release 3.x can also support any third party hardware 
connection compatible with CodeWarrior General Debug Interface (GDI) integrated in the debugger. 

8.1 Multilinks 
The Multilink is an easy to use, low-cost development tool for Freescale’s HC(S)12 
Flash MCUs. It provides the interface for in-circuit emulation, debugging and 
programming through the HC(S)12’s standard BDM serial debug/breakpoint 
interface. There are several versions of the Multilink target interface (see above) 

8.2 Cyclone and CyclonePRO 
The CyclonePRO version is available that supports multiple host-target interfaces: 
serial, parallel, USB and Ethernet to BDM. 
 
 
 

8.3 InDART (SofTec Microsystems) 
USB-based inDART-HC(S)12 takes advantage of Metrowerks’ CodeWarrior 
Development Studio for HC12 and the ISP (In-System Programming) feature to 
program the FLASH memory of the target microcontroller. Together with 
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CodeWarrior, inDART-HC(S)12 provides you with everything you need to write, compile, download, in-
circuit emulate and debug user code. inDART-HC(S)12 Design Kits come together with an Evaluation Board 
to permit an easy and fast start-up. C and Assembly examples are available for a first debugging process. 
Contact SofTec Microsystems or Metrowerks distributors directly. 

 

9 Hardware Products: Part Numbers 
 

Product Part number 
Multilink12 cable Parallel to BDM M68MULTILINK12 

USB Multilink cable USB to BDM USBMULTILINKBDM 

Cyclone Pro M68CYCLONEPRO 

10 Pricing 

For reasons of consistency, pricing is not indicated anymore in this document. Please consult Product 
Availability Guides or contact the nearest Metrowerks office. 

11 Licensing 

WEB licensing is in the works, look for an update in future releases of this document. 

CodeWarrior Development Studio for HC(S)12 can be licensed in different ways: 

- The Special Edition without any license key is limited to 1Kbytes of code, 

- The Special Edition requires a ‘free of charge’ license key that is not time nor node limited.  

- The Standard and Professional Editions require license keys that can be floating licenses, dongle 
licenses or locked to a computer 

 

12 Getting started with Special Edition 

12.1 Option 1: Obtaining the CD 

They are several ways to obtain the CD containing CodeWarrior Development Studio for HC(S)12. 

12.1.1 On-Line buy 

CodeWarrior Development Studio for HC(S)12 can be purchased directly from our Web site: 
Link to request free CD 

12.1.2 Request from Metrowerks 

The is a link for on-line request for an evaluation CD 
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In case of difficulty, address and phone numbers of our local offices can be found on our 
site: 
http://www.metrowerks.com/MW/About/location.htm 

12.1.3 Request from Freescale LDC 

Freescale Literature Distribution Center (LDC): 1-800-441-2447 

Request: CWX-HXX-SE 

12.2 Option 2: Downloading the software 

CodeWarrior for HC(S)12 
CodeWarrior for HC(S)12 can be downloaded from our Web site: 
http://www.metrowerks.com/MW/Develop/Embedded/HC12/Downloads 
And select “Download”. The first time, you will be presented with a questionnaire. Fill in 
this questionnaire and submit it. When this is done, you will immediately receive an email 
with the instructions to download the software and get the license key. 
Click on the link to download CodeWarrior Development Studio and when this is done, 
install the software. After this, see the section below on ‘getting a free license’ in this 
document. 
 
NOTE: For reasons of file size, some documentation is not included in the main 
CodeWarrior file. This documentation is related to manuals, technical notes and examples. It 
is available from the Metrowerks web site: 
http://www.metrowerks.com/MW/Develop/Embedded/HC12/Downloads 
and select “manuals”, “technical notes” and “manuals” desired. 
 

Service Packs 
Metrowerks is committed to supporting the family of 68HC(S)12 products with the best 
possible development tools. New derivatives are also introduced that may require dedicated 
files or software modules to be supported by the existing version of the tools. Service packs 
are made available for download on Metrowerks web site. Visit: 
http://www.metrowerks.com/MW/download/default.asp 
Click on the link for “Updates and Patches”, this will take you to the page with the service 
packs available for a specific CodeWarrior release. 

 

12.3 Getting a free license (Special Edition) 
WARNING: registering for a permanent free license (Special Edition) is different from registering a 
purchased license (Standard or Professional) 

Special Edition is free but requires a ‘Special Edition Key” to be activated. Without any key, the code size 
limitation (C object code) is 1Kbytes. To enable the 32Kbytes, simply register and get your free key.  
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12.3.1 If you have downloaded CodeWarrior Development Studio 

In this case, you have filled out the questionnaire and received an email with instructions. 
You have downloaded the software and installed it. 

Click on the second link of the email to download a ZIP file containing the free of charge 
license key for the Special Edition and a copy of the Quick Start Guide. 

12.3.2 If you have received a CD with CodeWarrior Development Studio  

In this case, you have installed the software from the CD and just need the free of charge 
license key for the Special Edition. 

Go to the Metrowerks Web site 
http://www.metrowerks.com/MW/Develop/Embedded/HC12/Downloads 

And select “Download”. The first time, you will be presented with a questionnaire. Fill in 
this questionnaire and submit it. When this is done, you will immediately receive an email 
with the instructions to download the software and get the license key. 

Click on the second link in the email to download a ZIP file containing the free of charge 
license key for the Special Edition and a copy of the Quick Start Guide. 
If you have any registration questions, please contact register@metrowerks.com 
 
The HC12 Quick Start has been updated with Special Edition licensing instructions. Special 
Edition licensing instructions have also been included on the back cover of the software 
packaging for CWX-HXX-SE.  

12.4 Installing the keys 
To install keys, follow the instructions emailed in response to a request for a license key. 
These instructions require you to copy the information received in a license.dat file and paste it into the 
original license.dat file on your hard disk. You can open the license file from the ‘start’ menu. 
 
If you have any licensing questions, please contact license@metrowerks.com 

 

13 Getting started with Standard or Professional Editions 

13.1 Ordering 

Standard Edition, Professional Edition, yearly technical support packages and upgrade packages can 
be ordered directly from the Metrowerks WEB site: 

Click on the following link to on-line store for HC(S)12 products 
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13.2 Registering and getting a license 

You need a license key to activate a Standard Edition or a Professional Edition. You can run 
mwregister.exe that has been installed from the CD-ROM or you can log on to:  
http://www.metrowerks.com/MW/Secure/Register/default.htm 

You will be asked to enter the registration number found on the registration card received with the 
package. If you have any licensing questions, please contact license@metrowerks.com 

13.3 Installing the key 
To install keys, follow the instructions emailed in response to a request for a license key. 
These instructions require you to copy the information received in a license.dat file and paste it into 
the original license.dat file on your hard disk. 
If you have any licensing questions, please contact license@metrowerks.com 

14 Tutorials 
There is no specific tutorial available at this time for 68HC(S)12. Please check the 68HC08 web pages and 
read the tutorials that demonstrate how easy to use the CodeWarrior Development Studio and how to design 
your own application using state-of-the-art tools. 
 
http://www.metrowerks.com/MW/Develop/Embedded/HC08/HC08_Tutorials.htm 
 

15 Training and Software Services 
Training 

The training team can provide various types of training session, at Metrowerks or in-house. 

http://www.metrowerks.com/MW/Services/Training/default.htm 
 

Software Services 
We can extend your development capabilities and enhances your team’s productivity: 

- Hardware and software integration 
- Custom software development  
- Support for new platforms  
- Custom training services 
- Project porting services  
- API consulting  

The team has expertise in Embedded and Desktop applications. 

http://www.metrowerks.com/MW/Services/Default.htm 
 

16 Useful Links 
To visit CodeWarrior site or get technical support: 
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CodeWarrior:   http://www.freescale.com/codewarrior 
 
Technical Support: http://www.freescale.com/support 
 
 
Links to our Processor Expert tool and related beans: 
 

http://www.processorexpert.com 
 
For introduction on the beans 

http://www.processorexpert.com/eb/main.html 
 
For details on beans to support external devices (A/D, displays, other beans) 

http://www.processorexpert.com/eb/hw_beans.html 
 
For details on software only beans (data processing, process control, other beans) 

http://www.processorexpert.com/eb/sw_beans.html 
 
For details on beans related to internal MCU modules (SCI, SPI, A/D, other beans) 

http://www.processorexpert.com/eb/basic_beans.html 
 
When you get to individual beans, the left menu allows you to see details and usage example. 

 
Links to board vendors: 
 

SofTec Microsystems:  http://www.softecmicro.com 
 
Axiom:    http://www.axman.com 
 

Technological Arts:  http://www.technologicalarts.com 
 
Future Electronics:  http://www.futureerc.com 
 

Elektronik-Laden:  http://www.electronikladen.de 
 

17 Frequently Asked Questions and Technical Notes 
The CodeWarrior Development Studio CD contains technical notes (TN) with the most recent ‘hints and tips’ 
from our software designers.  

18 Benchmarks 
Benchmarking probably is an 'art' unto itself. It may be difficult to find the 'ideal' switches for benchmarking. 
It heavily depends on the benchmark and the goal you want to achieve. Code density is one thing, and code 
speed another. The compiler manual already lists an option set for 'general' purpose, and the 'Smart Sliders' in 
the compiler are helping in this area too. 
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There are several aspects to consider in optimizing the code and the result will be a best combination of these 
rather than one only piece. If compiler switches play an important role, the way the linker is used plays a 
significant role for the final application as well as the programming style and the goals to achieve. 
For a very critical benchmark, we suggest that customers work with our engineering team which already has 
a lot of expertise and, quite important, they know their tools best. 
 

19 Documentation 
There is a lot of documentation available,  

-  Manuals, tutorials, examples on the web,  
-  Manuals on the CD. 

There is a lot of documentation on the different components of CodeWarrior Development Studio.  
All the manuals can be found on the CD and can be installed on the hard drive, depending on the installation 
chosen. Look for the folder “CodeWarrior Manuals” on the CD or in the directory where CodeWarrior 
Development Studio is installed. 
 
For reasons of file size, some documentation is not included in the main CodeWarrior file that can be 
downloaded from the web. This documentation is related to some manuals and is available from the 
Metrowerks web site at the page “tutorials and manuals”. 
 
Printed manuals can also be ordered at the following site:  http://www.vervante.com/metrowerks 


